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About the Course

• (Hopefully) English Teaching
• Monday 13:30 to 16:05 六教6A117,Week 1-16

Special#1: No formal lecture at 11th week. 
Special#2: Poster session will be on 16th week Thursday

• Offline class required
• For special cases, contact TA

• Office Hour
• 六教6A117, Mon 12:30 to 13:30 (TAs will be always there)
• Email me if you want a 1-on-1 conversation with me

• Use 钉钉 for announcements and questions
• Course Website: https://openpsi-project.github.io/DeepLearning2025/
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Syllabus
• 8 writing homework (due in 1 week) + 4 coding project + final project 

(2~3 members/team) + final exam
# Date Topic Homework Note
1 2/17 Overview HW0 CP1 release
2 2/24 Supervised Learning (1) CP2 release
3 3/3 Supervised Learning (2) HW1 CP1 due; 
4 3/10 Energy-Based Model HW2
5 3/17 Variational Autoencoder HW3 CP2 due; CP3 release
6 3/24 Generative Adversarial Network HW4
7 3/31 Normalizing Flow & Diffusion Model HW5
8 4/7 Sequence Modeling (1) HW6 CP 4 release; CP3 due;
9 4/14 Sequence Modeling (2) HW7 Project announcement

10 4/21 LLM and Advanced Topics
11 4/28 NO COURSE!! Q/A on Proposal; CP4 due
12 5/10 Learning Structured Data HW8 Project proposal due after holiday
13 5/12 Advanced Topics: Self-Supervised Learning, 

Meta-Learning, AutoML
14 5/19 Security, Interpretability and Fairness
15 5/26 Frontier and Applications (Guest Lecture)
16 6/5 Final Project Poster Session Thursday! Project report due TBA

A lot of work!
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Grading

• Overall: Homework 20% + Coding 40% + Project 20% + Final 20%
• Coding: 10% each

• backpropagation; classification; generative models; language models; 
• Homework: 

• We will convert all the homework grades into 20 pts
• No late submission allowed 

• Project: team project; report + poster presentation; 
• Each member’s contribution must be clearly stated

• STRICT HOMEWORK POLICY!
• Discussion is encouraged
• Ask your TAs, friends, or even AIs
• But do your homework on your own
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About the Course

• Prerequisites
• Linux and Python coding
• Calculus & basic Machine Learning
• Mentally ready for heavy engineering work  

• What will you learn?
• Not about “how to import python packages”!
• Not about “theorem proving”

• Formal Mission
• How to train neural nets from data
• How to use neural nets to solve problems
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Some Terminologies

Data

Label
𝑌𝑌

Sample
𝑋𝑋

Neural Network (model, 𝑓𝑓)
Goal: derive a neural net model (𝒇𝒇) from data
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The Problems to Solve (in a nutshell)

Classification
(discriminative model)

𝑌𝑌𝑋𝑋

Generation
(generative model)

𝑌𝑌 𝑋𝑋

(a bit more detailed) Goal: derive a discriminative/generative neural net model from data
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About the Course

• What will be covered in the course?
• How to design a neural network (network architecture)
• Algorithms to learn a good model for 𝑋𝑋 → 𝑌𝑌/ 𝑌𝑌 → 𝑋𝑋
• How to apply a learned model to solve different real-world challenges
• Broad understanding of active research domains

You don’t need to understand every details in the class

A class about “tools” and “ideas” of neural nets for practical problems
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Additional References

• Deep Learning
• https://mitpress.mit.edu/books/deep-learning

• Dive into Deep Learning
• https://d2l.ai/

• Use Google!
• DeepMind and OpenAI resources
• CMU & Stanford & Berkeley Courses
• Some wonderful BLOGs

• https://towardsdatascience.com/
• https://colah.github.io/
• https://lilianweng.github.io/lil-log/
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Lecture 1: Overview

• Part 1: A comprehensive history recap of deep learning
• with many lessons

• Part 2: some programming basics
• with HW0 released
• CP1 will be released this week but no hurry
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Deep Learning is Everywhere
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What is deep learning?
Neural Networks Representation Learning
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What is deep learning?

• Deep Learning is a class of machine learning methods that use neural 
networks to learn representations from raw data.

AI 
(e.g., search, 

expert system)

Machine 
Learning

(e.g., SVM)

Representation 
Learning

(e.g., PCA, lasso)
Deep Learning

What makes DL so special?
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What is deep learning?

Feature Engineering
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What is deep learning?

• Deep Learning is a class of machine learning methods that use neural 
networks to learn representations from raw data.

• What makes deep learning so special?
• Conventional machine learning (shallow learning)

First hand-design features 𝜙𝜙(𝑥𝑥) for each 𝑥𝑥
Then learn 𝑓𝑓 w.r.t. 𝜃𝜃𝑓𝑓 by 𝑦𝑦 = 𝑓𝑓 𝜙𝜙 𝑥𝑥 , 𝜃𝜃𝑓𝑓  w. 𝜙𝜙(𝑥𝑥) fixed

• Deep Learning (end-to-end learning both 𝜙𝜙 and 𝑓𝑓 w.r.t 𝜃𝜃)
𝑦𝑦 = 𝑓𝑓 𝑁𝑁𝑁𝑁 𝑥𝑥; 𝜃𝜃𝑁𝑁𝑁𝑁 ; 𝜃𝜃𝑓𝑓  w. 𝑁𝑁𝑁𝑁(⋅) a neural net with parameter 𝜃𝜃𝑁𝑁𝑁𝑁

Assumption#1: a neural network can (approximately) represent any function
Assumption#2: a smart algorithm can (automatically) derive a good neural net
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What is Neural Network?

• Artificial Neural Network (ANN, or NN) is a 
computing system based on a collection of 
connected units or nodes called artificial neurons, 
which loosely model the neurons in a biological 
brain.

• Connections are also called edges
• Neurons and edges typically has weights associated
• A weight adjusts as learning proceeds
• The output of each neuron is computed by some non-

linear function of the sum of its inputs

• How is it invented? A feedforward NN
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The Rise of Connectionism

• The human brain is a 
connectionist machine

• Bain, A. (1873). Mind and body. 
The theories of their relation. 
London: Henry King.

• Ferrier, D. (1876). The Functions 
of the Brain. London: Smith, 
Elder and Co.

• The processing/capacity of the 
brain is a function of these 
connections

Many neurons connect in to each neuron
Each neuron connects out to many neurons

Neurons can be activated
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Connectionist Machines

• Connectionist machines emulate brain structure
• A computation network of processing elements

• All world knowledge is stored in the connections 
between the elements

• Neural networks are connectionist machines

• The machine has many non-linear processing units
• Cyclic Connections may also define memory
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Turing’s Connectionist Machines

• B-type machine
• A unit is a NAND node (NOT+AND)
• An edge can modify the signal
• Learning: edge types are determined 

by an A-type machine

• Intelligent Machinery
• Alan Turing, as early as 1948

• Unfortunately, it was dismissed by 
his employer and went 
unpublished until 1968, 14 years 
after his death.

Before his “Turing Test” paper in 1950
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McCulloch-Pitts Neuron

• The first mathematical model of neuron (1943)
• The model was specifically targeted as a computational model 

of the "nerve net" in the brain.
• Boolean unit

• 𝑥𝑥𝑛𝑛 ∈ {0,1}
• 𝑔𝑔 𝑥𝑥 = ∑𝑖𝑖 𝑥𝑥𝑖𝑖
• 𝑦𝑦 = 𝑓𝑓 𝑔𝑔 𝑥𝑥 = 𝕀𝕀 𝑔𝑔 𝑥𝑥 > 𝜃𝜃  (or flip)

• Represent any Boolean functions
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McCulloch-Pitts Neuron

• The first artificial neuron. 
• A Logical Calculus of the Ideas Immanent in Nervous Activity, 1943
• McCulloch: Neurophysiologist, Prof at U. Illinois at Chicago
• Pitts: 20 year-old homeless wannabe logician who arrived at his door
• After five years of unofficial studies, the University of Chicago awarded Pitts an Associate of Arts (his 

only earned degree) for his work on the paper
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Hebbian Learning

• The first learning algorithm for neural networks
• “Organization of behavior”, Donald Hebb, 1949

• Principle: Cells that fire together wire together.
• If neuron 𝑥𝑥𝑖𝑖  repeatedly triggers neuron 𝑦𝑦, the synaptic knob (神经突触) 

connecting 𝑥𝑥𝑖𝑖  to gets larger

• Mathematical model:
𝑤𝑤𝑖𝑖 = 𝑤𝑤𝑖𝑖 + 𝜂𝜂 𝑥𝑥𝑖𝑖 𝑦𝑦 

𝑤𝑤𝑖𝑖  is the weight between 𝑥𝑥𝑖𝑖  and 𝑦𝑦
• The basis of many learning algorithms in Machine Learning!
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The First Implementation Attempt

• SNARC (Stochastic Neural Analog 
Reinforcement Calculator)

• 1951 summer
• 40 units with random wires
• An operator will press a button to give reward 

to the machine

• Marvin Minsky
• 1969 Turing Award
• Founder of MIT CSAIL
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The First Spring of AI

• Perceptron, 1958 by Frank Rosenblatt
• First practical implementation of learning neural networks

• Mark 1 perceptron: a machine for image recognition
• 400 photocells, randomly connected to the "neurons". 
• Weights were encoded in potentiometers (继电器)
• Weight updates during learning

• “the embryo of an electronic computer that [the Navy] 
expects will be able to walk, talk, see, write, reproduce 
itself and be conscious of its existence.” --- New York 
Times, 1958
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The MIT Summer Vision Project

• Marvin Minsky
• 1969 Turing Award
• Founder of MIT CSAIL

• The project at 1966 summer
• “The summer vision project is an attempt to use our summer workers 

effectively in the construction of a significant part of a visual system. 
The particular task was chosen partly because it can be segmented 
into sub-problems which allow individuals to work independently 
and yet participate in the construction of a system complex enough to 
be real landmark in the development of ‘pattern recognition’‘”

• Summary
• “奋斗一个夏天，解决模式识别” A Failed Attempt 
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The Perceptron

• Simplified Mathematical Formula

• 𝑦𝑦 = �1 if ∑𝑖𝑖 𝑤𝑤𝑖𝑖𝑥𝑥𝑖𝑖 − 𝑇𝑇 > 0
0 else

• 𝑤𝑤 weights; 

• Learning rule
• 𝑤𝑤 = 𝑤𝑤 + 𝜂𝜂 𝑑𝑑 𝑥𝑥 − 𝑦𝑦(𝑥𝑥) 𝑥𝑥
• Update the weights whenever the 

perceptron output is wrong
• Convergence on linearly-separable case
• It can mimic any Boolean gates (AND, 

OR, NOT)
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The Perceptron

• The XOR problem
• The book, Perceptrons, at 1969 by Marvin Minsky

• Multi-layer Perceptron!
• Also suggested by Marvin Minsky at 1969

• A Multi-layer perceptron can compose 
arbitrarily complicated Boolean functions!
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The Perceptron

• Perceptron on real inputs
• Construct a perceptron for the following decision boundary
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The Perceptron

• Perceptron on real inputs
• A more complex case

MLPs can represent arbitrarily complex 
decision (classification) boundaries

MLPs are universal Boolean functions
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The Perceptron

• How many layers are necessary for Boolean functions?
• Two-layered MLPs are universal Boolean functions

• How many perceptrons in hidden layers are required for a 𝑁𝑁-variable 
function?

• The XOR function over 𝑁𝑁 variables
• 𝑂𝑂 2𝑁𝑁−1  perceptrons

• Lower-bound for the parity function (Håstad, 1987)

• depth-𝑘𝑘 circuits require size exp Ω 𝑁𝑁
1

𝑘𝑘−1

• A deep network is preferred!
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The Perceptron

• How to learn the weights of a multi-layer perceptron?
• An intuitive example
• Low-level: linear boundaries
• Hidden-level: convex regions
• Exponential search?

• Training a 3-node neural network is NP-complete
• Avrim L. Blum & Ronald L. Rivest, Neural Networks, 1992
• Assumption: a 2-layered network with 𝑛𝑛-variable input and thresholding 

functions
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The First AI Winter

• The perceptron cannot represent the XOR problem
• Marvin Minsky, 1969

• The notion of NP-completeness
• Levin-Cook Theorem, 1971
• Karp's 21 NP-complete problems, 1973

• Sad Fact: Frank Rosenblatt died in July 1971 on his 43rd birthday 
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The First AI Winter

• The Lighthill report, 1973
• Artificial Intelligence: A General Survey by James Lighthill
• Evaluation of the state of AI research in the United Kingdom
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The First AI Winter

• The Lighthill report, 1973
• Artificial Intelligence: A General Survey by James Lighthill
• Evaluation of the state of AI research in the United Kingdom

• DARPA Funding Cuts, 1974
• DARPA's own study (the American Study Group) suggested that most AI 

research was unlikely to produce anything truly useful in the foreseeable 
future

• A decade-long AI winter until the success of expert system in 1980s
• And then followed by the second (longer) AI winter in 1990s 

Summary:
• MLP is Universal Function Approximator
• But hopeless to find the optimal solution
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Differentiable Functions

• Why is training so hard in classical multi-layer perceptrons?
• Perceptron training: adjust weights when error
• You can alter weights a lot without changing the error
• No indication of improvement  combinatorial optimization
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Differentiable Functions

• The differentiable approximation of thresholding
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Differentiable Functions

• A probability interpretation of sigmoid function
• Differentiable function  we now have gradient!
• The direction of improvement
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Differentiable Functions

• The Backpropagation Algorithm
• Learning representations by back-propagation errors, Nature, 1986
• By David Rumelhart, Geoffrey Hinton, Ronald Williams
• Key idea: update weights by back-propagating gradients
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Differentiable Functions

• The Backpropagation Algorithm
• Learning representations by back-propagation errors, Nature, 1986
• By David Rumelhart, Geoffrey Hinton, Ronald Williams
• Key idea: update weights by back-propagating gradients

• For the first time, it shows such a backward gradient computation 
method can automatically learn features

• Although the idea can be traced back to Paul Werbos’s dissertation at 1974
• Remark: Still NO guarantee for optimal solution
• It is particularly important to make an idea work!

Lecture 1, Deep Learning, 2025 Spring OpenPsi @ IIIS

2/17 Copyright @ IIIS, Tsinghua University 43



Revival of Connectionism

• Geoffrey E. Hinton
• PhD in AI at 1978, U. Edinburgh (short of funding)
• Worked at UCSD and CMU (backprop)
• Professor Emeritus at U. Toronto
• Inventor of Boltzmann machine, distributed 

representations, mixtures of experts
• The beginning of DL era in 2012
• Turing Award at 2018; Nobel Prize at 2024

• Comments
• 1978 ~ 2012  two AI winter and multiple waves
• Many ideas has been invented for decades
• The perspective of doing great science

Fun story: Geoffrey Everest Hinton 
• great-great-grandson of logician 

George Boole
• middle name is from another 

relative, George Everest
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Revival of Connectionism (1990s)

• The convolutional neural network (CNN)
• Backpropagation applied to handwritten zip code recognition
• Neural Computation 1989
• By Yann LeCun, et al., from AT&T Bell Lab
• Remark: idea can be traced back to K. Fukushima, 1980

• LeNet-5 at 1998
• The first commercial application of CNN
• The foundation of modern computer vision

LeNet-1 at 1993
Remark: 32-year-old Yann LeCun

Fun fact: A pos-doc of Hinton 

10-year effort to make CNN work!
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Revival of Connectionism (2000s)

• Neural Networks for Natural Language Processing
• A neural probabilistic language model, NIPS 2000 (neural language model)
• By Bengio, Yoshua, Réjean Ducharme, and Pascal Vincent
• Neural Machine Translation by Jointly Learning to Align and Translate, 

ICLR 2015 (attention)
• By Dzmitry Bahdanau, KyungHyun Cho, Yoshua Bengio
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Revival of Connectionism (2000s)

• Neural Networks for Natural Language Processing
• A neural probabilistic language model, NIPS 2000 (neural language model)
• By Bengio, Yoshua, Réjean Ducharme, and Pascal Vincent
• Neural Machine Translation by Jointly Learning to Align and Translate, 

ICLR 2015 (attention)
• By Dzmitry Bahdanau, KyungHyun Cho, Yoshua Bengio

• The foundation of deep NLP models
• Prof. Yoshua Bengio, Turing Award 2018
• 15 years of works, finally revolutionize the NLP field
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Revival of Connectionism: The New Spring

• Speech Recognition, 2012
• Led by G. Hinton; Joint work with Google, MSR and IBM
• Outperforms existing methods with a huge gap (1.3% ~ 10%)
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Revival of Connectionism: The New Spring

• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012

• Led by Andrew Ng and Jeff Dean, at Google X Lab
• A neural network of 16,000 CPUs trained on YouTube videos
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Revival of Connectionism: The New Spring

• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012

• By Alex Krizhevsky, Ilya Sutskever and Geoffrey Hinton

2012 is a magical year!
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Revival of Connectionism: The New Spring

• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014

• By DeepMind
• First time apply deep learning in reinforcement learning
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Revival of Connectionism: The New Spring

• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016

• by DeepMind
• Defeat 李世乭 by 4:1, March 2016
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Revival of Connectionism: The New Spring

• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016

• It reduces translation errors by 60% compared to Google's phrase-based 
production system

• Only 2~3 years of development
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Revival of Connectionism: The New Spring

• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016
• OpenAI’s RL Projects, 2019

• OpenAI Five defeated OG in Dota II (2:0)
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Revival of Connectionism: The New Spring

• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016
• OpenAI’s RL Projects, 2019

• OpenAI Five defeated OG in Dota II (2:0)
• First time to use pure deep RL to solve Rubik’s cube manipulation 
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Revival of Connectionism: The New Spring

• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016
• OpenAI’s RL Projects, 2019
• GPT-3, 2020

• First time to show big language models can be few-shot learner
• The start of the era of “big pretrained models”

Lecture 1, Deep Learning, 2025 Spring OpenPsi @ IIIS

2/17 Copyright @ IIIS, Tsinghua University 56



Revival of Connectionism: The New Spring

• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016
• OpenAI’s RL Projects, 2019
• GPT-3, 2020
• AlphaFold, 2020

• A new trend of “AI for science” & Nobel Prize 2024 
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Revival of Connectionism: The New Spring

• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016
• OpenAI’s RL Projects, 2019
• GPT-3, 2020
• AlphaFold, 2020
• AlphaCode, 2021
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Revival of Connectionism: The New Spring

• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016
• OpenAI’s RL Projects, 2019
• GPT-3, 2020
• AlphaFold, 2020
• AlphaCode, 2021

• AIGC, 2022
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• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016
• OpenAI’s RL Projects, 2019
• GPT-3, 2020
• AlphaFold, 2020
• AlphaCode, 2021

• AIGC, 2022
• ChatGPT, 2022

Revival of Connectionism: The New Spring
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• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016
• OpenAI’s RL Projects, 2019
• GPT-3, 2020
• AlphaFold, 2020
• AlphaCode, 2021

• AIGC, 2022
• ChatGPT, 2022

Revival of Connectionism: The New Spring
Lecture 1, Deep Learning, 2025 Spring OpenPsi @ IIIS

2/17 Copyright @ IIIS, Tsinghua University 61



• AIGC, 2022
• ChatGPT, 2022
• GPT4-V, 2023

• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016
• OpenAI’s RL Projects, 2019
• GPT-3, 2020
• AlphaFold, 2020
• AlphaCode, 2021

Revival of Connectionism: The New Spring
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• AIGC, 2022
• ChatGPT, 2022
• GPT4-V, 2023
• Sora, 2024

Revival of Connectionism: The New Spring

• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016
• OpenAI’s RL Projects, 2019
• GPT-3, 2020
• AlphaFold, 2020
• AlphaCode, 2021

Prompt: A stylish woman walks down a Tokyo 
street filled with warm glowing neon and 
animated city signage. She wears a black 
leather jacket, a long red dress, and black 
boots, and carries a black purse. She wears 
sunglasses and red lipstick. She walks 
confidently and casually. The street is damp 
and reflective, creating a mirror effect of the 
colorful lights. Many pedestrians walk about.
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• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016
• OpenAI’s RL Projects, 2019
• GPT-3, 2020
• AlphaFold, 2020
• AlphaCode, 2021

• AIGC, 2022
• ChatGPT, 2022
• GPT4-V, 2023
• Sora, 2024

Revival of Connectionism: The New Spring

• O1, 2024
• AI can think
• The beginning of 

Reasoning Model
• O3 released later
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• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016
• OpenAI’s RL Projects, 2019
• GPT-3, 2020
• AlphaFold, 2020
• AlphaCode, 2021

• AIGC, 2022
• ChatGPT, 2022
• GPT4-V, 2023
• Sora, 2024

Revival of Connectionism: The New Spring

• O1, 2024
• OpenAI Operator, 2024
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• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016
• OpenAI’s RL Projects, 2019
• GPT-3, 2020
• AlphaFold, 2020
• AlphaCode, 2021

• AIGC, 2022
• ChatGPT, 2022
• GPT4-V, 2023
• Sora, 2024

Revival of Connectionism: The New Spring

• O1, 2024
• OpenAI Operator, 2024

• The beginning of 
general automatous 
agent
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• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016
• OpenAI’s RL Projects, 2019
• GPT-3, 2020
• AlphaFold, 2020
• AlphaCode, 2021

• AIGC, 2022
• ChatGPT, 2022
• GPT4-V, 2023
• Sora, 2024

Revival of Connectionism: The New Spring

• O1, 2024
• OpenAI Operator, 2024
• DeepSeek R1, 2024

• First open-source LLM on 
par with OpenAI
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• Speech Recognition, 2012
• Google’s Brain Recognizes Cat Videos, 2012
• AlexNet in ImageNet Challenge, 2012
• Deep Q-Learning, 2014
• AlphaGo, 2016
• Google’s Machine Translation System, 2016
• OpenAI’s RL Projects, 2019
• GPT-3, 2020
• AlphaFold, 2020
• AlphaCode, 2021

• AIGC, 2022
• ChatGPT, 2022
• GPT4-V, 2023
• Sora, 2024

Revival of Connectionism: The New Spring

• O1, 2024
• OpenAI Operator, 2024
• DeepSeek R1, 2024

• First open-source model 
on-par with OpenAI

……
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The Era of Deep Learning

• Rapid Advances in Vision
• Image Classification
• Larger/Deeper models
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The Era of Deep Learning

• BIG data + Huge Model in NLP
• Without any use of human knowledge
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The Era of Deep Learning

• Turing Award at 2018
• Geoffrey Hinton, inventor of modern backpropagation and many fundamental 

ideas
• Yann LeCun, Inventor of convolutional neural networks, foundation of modern 

pattern recognition
• Yoshua Bengio, Inventor of neural 
language model and attention
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The Era of Deep Learning

language model and attention
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The Era of Deep Learning
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The Era of Deep Learning
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A Historical Perspective

• The history of deep learning
• Original over-optimism in 1960s and then AI winter
• A “cold” research area for decades (1970s ~ 2000s)
• Magic year of 2012 ---- but “Rome wasn't built in a day”

• What’s next “magic year”? It’s your turn!
• We can we learn from history?

• Be determined for great science!
• Be respectful to prior works ---- most ideas have been explored
• Be aware of entire literature beyond those hot topics!
• Deep Learning is the science of engineering …
• and it is critical to make things work!

• Idea is cheap. Show me the code/model!

Be ready to solve real-world challenges &
Get your hands dirty!!!
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Coding Time!

• You need to
• Use Google & ChatGPT! (so get your network access ready)
• Be ready to use Python and PyTorch
• Be prepared to write a well-written report in English (Grammarly 

recommended! Or ask your AI to help check it first …)
• Learn to use cloud compute (no need for HW1, more instructions coming)

• Computation
• Your laptop for debugging and coding
• Google CoLab for light tuning (this lecture)
• AutoDL for heavy training (in future lecture)

• Each enrolled IIIS student will have 800 RMB compute budget
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Google Colab Tutorial
Deep Learning 2025 Spring

Jingzhi Cui
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Purpose

• Introduce the usage of Google Colab
• Help the ones who are not familiar with Python or PyTorch
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Google Account
• https://accounts.google.com/SignUp?hl=en
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Google Colab

• Colaboratory is a Google research project created to help disseminate 
machine learning education and research.

• It’s a Jupyter notebook environment that requires no setup to use 
and runs entirely in the cloud.

• It allows you to use free Tesla T4 GPU it also gives you a total of 16GB 
of RAM, and you can use it up to 12 hours in row (You need to restart 
the session after 12 hours)
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Google Colab

• Colaboratory is a Google research project created to help disseminate 
machine learning education and research.

• It’s a Jupyter notebook environment that requires no setup to use 
and runs entirely in the cloud.

• It allows you to use free Tesla K80 GPU it also gives you a total of 
12GB of RAM, and you can use it up to 12 hours in row (You need to 
restart the session after 12 hours)
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How to Upload Your Code

• From local (our coding projects)
• File -> Upload Notebook -> Choose File from local

• From Google Drive (or other existing Colab notebooks)
• Don’t run codes directly!

• From GitHub
• File -> Open Notebook
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Set Up Environment

• Hardware environment
• Connect to hosted runtime by clicking “Connect”
• Enable GPU (TPU):

• Edit -> Notebook Settings

• You can run shell command with a “!” prefix
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相当于连接到了一台服务器上
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选择使用 GPU 还是 CPU
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Set Up Environment

• Code environment
• Install necessary packages with “!pip install”
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Set Up Environment

• Code environment
• Where am I?

• Upload/Mount necessary files/data
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Mount your google drive in Colab notebook
1. Open your Google drive

https://drive.google.com/drive/my-drive
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2. Create a new folder in My Drive
Mount your google drive in Colab notebook

Lecture 1, Deep Learning, 2025 Spring OpenPsi @ IIIS

2/17 Copyright @ IIIS, Tsinghua University 90



Mount your google drive in Colab notebook
3. Run the code in your colab

5. success

4. Click the link and enter your authorization code

6. Now you can access your google drive in Colab notebook in /content/drive/MyDrive
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Run Your Code

• Fill out the code in your homework
• Execute the code one-by-one in the notebook

• When you select any other code segments, then you should be able to see a 
number in [ ] area

• If there is no number within [ ], then you need to re-run that segment
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Run your code in google drive
1. Upload your code to you google drive (linear.py)
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Run your code in google drive
2. Mount your google drive
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Run your code in google drive
3. run your code in the google drive
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Download Your Checkpoints

• Save checkpoints in Google Drive frequently
• Download your files immediately after finishing the experiment

• File -> Download -> Download .ipynb
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Generate training data
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Define a Network
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Train the network
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The training progress
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Visualize the weight and bias of trained model
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PyTorch Example
• Load dataset
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PyTorch Example

• Define the network
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PyTorch Example
• Define the dataflow
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Notice:

• Save your data and model in google drive, otherwise, they may be lost 
when you disconnect.

• If you want to train your model using Colab for a long time, make sure 
you save your training states frequently and you can recover your 
training from these training states.

• Try it out yourself in HW0!
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• PyTorch linear: 
• https://colab.research.google.com/drive/1yS5kvHC_TQuWesPmon7W7hrD978tOJ2i?

usp=sharing

• Mount and run your code in google drive:
• https://colab.research.google.com/drive/163LrsNRHC48tCCGHhBfgqCyGCODXRmaR?

usp=sharing

• linear.py
• https://drive.google.com/file/d/1jdwTgo6Qf4PoPz5JEQwy-

KJoPncb30yt/view?usp=sharing

• PyTorch MNIST
• https://colab.research.google.com/github/rpi-techfundamentals/fall2018-

materials/blob/master/10-deep-learning/04-pytorch-mnist.ipynb

The example links
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Thanks!
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